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Overview of Office 2019 (for IT Pros)
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Office 2019 is the latest version of Microsoft's productivity software that's available as a one-time purchase from a
retail store or through a volume licensing agreement.

IMPORTANT

Office 2019 is separate from Office that's available through Office 365 (or Microsoft 365) plans. For example, if you've
deployed Microsoft 365 Apps for enterprise (previously named Office 365 ProPlus) to the users in your organization, you

don't need Office 2019. You already have all the features, and many more, that are included in Office 2019.

Volume licensed versions of Office 2019 are available for enterprise admins to download and deploy to the users
in their organization. This includes the following Office products:

e Office Professional Plus 2019
e Office Standard 2019

® Project Professional 2019

® Project Standard 2019

e Visio Professional 2019

e Visio Standard 2019

These Office products now use Click-to-Run, instead of Windows Installer (MSI), as the installation technology. But,
how you activate these Office products — for example, by using Key Management Service (KMS) — remains the
same.

Office 2019 for Mac is also available for volume licensed customers. For more information, see Deployment guide
for Office for Mac.

What's changed in Office 20197?

The biggest change since Office 2016 is that the installation technology used by the new volume licensed versions
of Office is Click-to-Run, instead of Windows Installer (MSI). Click-to-Run has been the installation technology for
most Office products since the release of Office 2013.

In addition to Click-to-Run, the following are some other changes that you need to be aware of:

o Office 2019 is supported on Windows 10 but isn't supported on Windows 7 or Windows 8.1. For more
information, review the system requirements.

e To configure and perform installations, you use the Office Deployment Tool, which is a free download from the
Microsoft Download Center. The Office Customization Tool that you previously used for Windows Installer (MSI)
is no longer used.

e Instead of downloading the installation files from the Volume Licensing Service Center (VLSC), you use the
Office Deployment Tool to download the installation files directly from the Office Content Delivery Network
(CDN) on the internet.

e When you install Office Professional Plus 2019, all apps are installed by default. But, you can configure the
Office Deployment Tool to exclude certain apps from being installed.

o Office 2019 is installed on the system drive, which is usually the C\ drive. The installation location can't be
changed.

e Updates to Office 2019, such as security updates and bug fixes, can be configured to be automatically
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downloaded and installed from the Office CDN. Individual downloads for each security update or bug fix aren’t
available.

What's stayed the same in Office 20197

Even though there is a different installation technology, you can still use the same software distribution tools, such
as Microsoft Endpoint Configuration Manager, that you currently use to deploy Office. Also, how you activate
volume licensed versions of Office — for example, by using Key Management Service (KMS) — remains the same.

The major version of Office 2019 is staying at 16.0, so some additional things are staying the same for those
upgrading from Office 2016, including the following:

e Existing Group Policy settings will continue to work, because the registry location for those settings will still be
located in HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Office\16.0 and
HKEY_CURRENT_USER\SOFTWARE\Policies\Microsoft\Office\16.0.

o Other registry locations and settings information that reference 16.0 will still apply.

e Add-ins and other extensibility solutions that are compatible with Office 2016 will most likely be compatible
with Office 2019 or will require only minimal testing.

What are the new features in Office 2019?

For information about the new features in Office 2019, see the “what's new" articles for Access, Excel, Outlook,
PowerPoint, Project, Visio, and Word. Office 2019 includes some, but not all, features that are available in versions
of Office that come with an Office 365 (or Microsoft 365) plan.

Office 2019 won't receive additional new features now that it has been released. If you want to get new Office
features on an on-going basis, you should consider moving to an Office 365 (or Microsoft 365) plan that includes
Office. Most of these enterprise plans include Microsoft 365 Apps for enterprise (previously named Office 365
ProPlus), which includes the same Office apps as Office Professional Plus 2019. For more information, see
enterprise options for Office 365 and What's new in Office 365.

How do | upgrade to Office 20197

We recommend that you uninstall existing versions of Office before you deploy Office 2019. If you're uninstalling
previous versions of Office products that were installed with Windows Installer (MSI), the Office Deployment Tool
can remove most of those for you as part of the installation of Office 2019. For more information, see Remove
existing versions of Office before installing Office 2019.

Additional information

o Office Professional Plus 2019 includes Access, Excel, Outlook, PowerPoint, Publisher, Word, and Skype for
Business.

e Thereisn'ta 2019 version of OneNote, but OneNote 2016 is available for Office 2019. For more information,

see Deployment guide for OneNote.

o All products in the Office 2019 are available in both 32-bit and 64-bit versions. We recommend 64-bit on
computers that have 4 gb or more of memory. But you should assess application compatibility and other factors
that might require you to use the 32-bit version. For more information, see Choose between the 64-bit or 32-bit
version of Office.

e After downloading the installation files, internet access isn't required to install, activate, or use Office 2019.

e Thereisn'ta 2019 version of SharePoint Designer or InfoPath. The last version for both products is 2013.

Related topics
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Deploy Office 2019 (for IT Pros)
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To configure and perform deployments of volume licensed versions of Office 2019, including Project and Visio, for
users in your organization, you use the Office Deployment Tool (ODT). The Office Customization Tool (OCT) that
you previously used for Windows Installer (MSI) is no longer used.

The installation files for Office 2019 are available on the Office Content Delivery Network (CDN) on the internet
instead of on the Volume Licensing Service Center (VLSC). You can install Office 2019 directly from the Office
CDN. Or, you can download the installation files from the Office CDN to a location on your local network, such as a
shared folder, and install Office 2019 from that location. You can use different methods for different sets of
computers in your organization. Whichever method you choose, you use the ODT.

Installing directly from the Office CDN requires the least amount of administrative effort and is recommended. But
you might have constraints that prevent you from installing directly from the internet. For example, some
computers might not have connectivity to the internet or you may have limited bandwidth to the internet.

Download the Office Deployment Tool from the Microsoft Download
Center

The Office Deployment Tool is a free download from the Microsoft Download Center. We recommend that you
always download and use the most current version of the ODT.

After you download the Office Deployment Tool, double-click on the officedeploymenttool executable (.exe) file to
extract the ODT files. When you are finished, you should have several files: setup.exe and some sample
configuration.xml files. For an Office 2019-specific sample, see Sample configuration.xml file to use with the Office
Deployment Tool.

The setup.exe file is the ODT and is a command-line tool that supports downloading and installing Office 2019.
The configuration.xml files are sample files to get you started. You use the configuration.xml file to provide settings
for the ODT to use when downloading or installing Office 2019. The configuration.xml is a simple xml file that can
be created and edited in any text editor, such as Notepad. You can name the file anything that you want, as long as
it retains the xml file extension.

Create the configuration.xml

Once you have a copy of the ODT, you need to create a configuration.xml file. You can create multiple
configuration.xml files to be used with the ODT. For example, you would create a configuration.xml file to
download and install the 64-bit version of Office Professional Plus 2019 in English and a different
configuration.xml file to install the 32-bit version of Visio Professional 2019 in French. When you run the ODT
from an elevated command prompt, you specify which configuration.xml file to use.

TIP

Instead of using a text editor to create your configuration.xml, we recommend that you use the Office Customization Tool
(OCT). The OCT provides a web-based interface for making your selections and creating your configuration.xml file to be
used with the Office Deployment Tool. For more information, see Overview of the Office Customization Tool. Please note that
this is different than the Office Customization Tool that you might have used in the past to install volume licensed versions
of Office that used Windows Installer (MSI) as the installation technology.
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There are a series of settings in the configuration.xml file that you configure to customize the Office 2019

download or installation. The following table lists the most common settings to configure in the configuration.xml

file.

CONFIGURATION

Where to download the Office
installation files to and where to install
Office from

For example, \\server\share (a shared
folder on your local network)

Which products to download or install

For example, Office Professional Plus
2019

Use Key Management Service (KMS) to
activate Office 2019

Use Multiple Activation (MAK) to
activate Office 2019

Which languages to download or install

For example, English (en-us) and French
(fr-fr).

Which proofing tools to install

CONFIGURATION. XML SETTING

SourcePath

Product ID

PIDKEY

PIDKEY

Language ID

Product ID

ADDITIONAL INFORMATION

If you don't specify a SourcePath when
using the ODT to install Office, the ODT
looks for the installation files in the
folder it's located in. If it doesn't find
the Office installation files there, it goes
to the Office CDN to get the installation
files.

We recommend that you install Office
directly from the Office CDN, if internet
connectivity and network bandwidth
make that possible.

Valid values for volume licensed
versions of Office 2019 include the
following:

- ProPlus2019Volume

- Standard2019Volume

- ProjectPro2019Volume

- ProjectStd2019Volume

- VisioPro2019Volume

- VisioStd2019Volume

For a list of Product IDs for other
volume licensed versions of Office
2019, such as Access 2019, see Product
IDs that are supported by the Office
Deployment Tool for Click-to-Run.

Enter the Generic Volume License Key
(GVLK) for KMS activation.

Enter the product key for MAK
activation.

You can install multiple languages at
the same time you're Installing Office
2019, or you can install them later.

For more information, see Deploy
languages for Office 2019.

The Product ID is "ProofingTools" and is
used in combination with the Language
ID.

For more information, see Deploy
languages for Office 2019.


https://docs.microsoft.com/en-us/office365/troubleshoot/installation/product-ids-supported-office-deployment-click-to-run
https://docs.microsoft.com/en-us/deployoffice/vlactivation/gvlks

CONFIGURATION CONFIGURATION.XML SETTING

Which edition of Office 2019 to OfficeClientEdition
download or install.

For example, the 64-bit version.

Which apps to install ExcludeApp

For example, all apps except Publisher.

Where to get security and quality UpdatePath
updates from.

For example, directly from the Office
CDN on the internet.

Which update channel to install from Channel
and get updates from

ADDITIONAL INFORMATION

Valid xml values are "32" and "64."

All Office products on the computer
must be of the same architecture. You
can't have both 32-bit and 64-bit
Office products installed on the same
computer.

We recommend 64-bit on computers
that have 4 gb or more of memory. But
you should assess application
compatibility and other factors that
might require you to use the 32-bit
version.

For more information, see Choose
between the 64-bit or 32-bit version of
Office.

By default, all apps included in Office
Professional Plus 2019 are installed.

For example, to not install Publisher,
you can include the following line in
your configuration.xml:

<ExcludeApp ID="Publisher" />

For more information, see ExcludeApp
element.

The default is to get updates directly
from the Office CDN on the internet.
This is recommended and requires the
least amount of administrative effort.

But if you need to update computers
that don't have connectivity to the
internet, you can specify that Office
gets updates, for example, from a
shared folder on your local network.
But this means that you must
download the updates from the Office
CDN and copy them to the shared
folder.

For more information, see Update
Office 2019 (for IT Pros).

Office uses the concept of update
channels to determine which updates
an installed version of Office receives.

For more information, see Update
channel for Office 2019.
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CONFIGURATION CONFIGURATION.XML SETTING ADDITIONAL INFORMATION

Whether to remove previous Windows RemoveMS| This is recommended.
Installer (MSI) versions of Office before
installing Office 2019 For more information, see Remove

existing versions of Office before
installing Office 2019.

TIP

More information about these configuration.xml settings is available here: Configuration options for the Office Deployment
Tool. Keep in mind that not all the information in that article applies to Office 2019. For example, the settings related to
shared computer activation, such as SharedComputerLicensing and SCLCacheOverride, don't apply to Office 2019.

Sample configuration.xml file to use with the Office Deployment Tool

The following is a sample configuration.xml file that can be used to either download or install the 64-bit version of
Office Professional Plus 2019 in English using a shared folder on your local network and activate by using MAK. If
you're using this configuration.xml to install Office 2019, previous Windows Installer (MSI) versions of Office are
removed as part of the installation process. Also, even though it's not specified in the configuration.xml file,
updates are automatically enabled and are configured to come directly from the Office CDN, because those are the
default settings.

<Configuration>
<Add SourcePath="\\Server\Share" OfficeClientEdition="64" Channel="PerpetualVL2019">
<Product ID="ProPlus2019Volume" PIDKEY="4#####- ###HHE - - HHHE - T >
<Language ID="en-us" />
</Product>

<Product ID="ProofingTools">
<Language ID="de-de" />
<Language ID="ja-jp" />
</Product>
</Add>
<RemoveMSI />
<Display Level="None" AcceptEULA="TRUE" />
</Configuration>

For the PIDKEY, replace #####-##t###-#it###-##H##-##### with your MAK client activation key.

Remove existing versions of Office before installing Office 2019

We recommend that you uninstall any previous versions of Office before installing volume licensed versions of
Office 2019. To help you uninstall versions of Office that use Windows Installer (MSI) as the installation technology,
you can use the Office Deployment Tool and specify the RemoveMSI element in your configuration.xml file.

There are several ways that you can use the RemoveMSI element when installing volume licensed versions of
Office 2019.

e Uninstall all Office products on the computer.
e |dentify any existing language resources, like language packs, and install the same languages.

e Keep some Office products and uninstall all other Office products on the computer.

RemoveMSI can be used to uninstall 2010, 2013, or 2016 versions of Office, Visio, or Project that were installed
using Windows Installer (MSI).

For more information about using RemoveMSI, see Remove existing MSI versions of Office when upgrading to


https://docs.microsoft.com/en-us/deployoffice/office-deployment-tool-configuration-options
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Microsoft 365 Apps. Even though this article is about Microsoft 365 Apps, most of the information also applies to
volume licensed versions of Office 2019.

Download the Office 2019 installation files

Once you have a copy of the ODT and have created your configuration.xml file, you can download the Office 2019
installation files to your local network. To do that, open an elevated command prompt, go to the folder where you
saved the ODT and the configuration.xml file, and type this command:

setup /download configuration.xml

If you have saved the configuration.xml file with a different name, use that name in the command.

It will look as if nothing is happening, but the download is happening in the background. Once the download is

complete, you are returned to a command prompt.

If you want to check that the files are downloading, go to the location you specified for your SourcePath in the
configuration.xml file. You should see a folder named "Office” with a subfolder named “Data.’ There will also be a
folder named with the version number of the download. For example, 16.0.10336.20044. Which files you see and
the names of the files depend on whether you are downloading the 32-bit or 64-bit version of Office and which
languages you are downloading.

Here some additional details about downloading Office 2019 installation files:

e You must download the 32-bit and 64-bit versions separately.

o All volume licensed versions of Office 2019 — such as Office Professional Plus 2019, Visio Professional 2019,
and Project Professional 2019 — are included in the same download, regardless of which products you specify
in the configuration.xml file. This helps you save disk space on your local network. The core files for the Office
2019 products are in the stream.x86.x-none.dat or stream.x64.x-none-dat file, depending if it's the 32-bit or 64-
bit version of Office.

Install Office 2019 by using the Office Deployment Tool

Once you have a copy of the ODT and have created your configuration.xml file (and downloaded the Office 2019
installation files to your local network, if necessary), you can install Office 2019. To do that, open an elevated
command prompt, go to the folder where you saved the ODT and the configuration.xml file, and type the following
command:

setup /configure configuration.xml

If you have saved the configuration.xml file with a different name, use that name in the command.

Once the installation is complete, you are returned to a command prompt and you can go open Office 2019

programs you've installed.

Install Office 2019 by using Microsoft Endpoint Configuration Manager

You can also use Microsoft Endpoint Configuration Manager to deploy volume licensed versions of Office 2019.
Configuration Manager (current branch) has a wizard that steps you through the process and builds the
configuration.xml file for you. Earlier versions of Configuration Manager require you to download the ODT and

create your own configuration.xml file.

e Configuration Manager (current branch): If you're using Configuration Manager (current branch), you
can use the Office 365 Client Installation wizard to deploy Office 2019. You must be using at least version



1710, but version 1806 is recommended. You'll see an entry for Office Professional Plus 2019 in the Office

365 Client Installation wizard. On that same page, you can also select to install Project and Visio.

e System Center 2012 R2 Configuration Manager: If you're using System Center 2012 R2
Configuration Manager, the steps are different and much more manual. First you need to get a copy of the
ODT from the Microsoft Download Center and create the appropriate configuration.xml file for your
deployment. Then, in Configuration Manager, you create an application and a deployment type. After that

you distribute the application and then deploy it.

Deploy languages for Office 2019

You can use the ODT and the configuration.xml file to install volume licensed versions of Office 2019, including

Project and Visio, in multiple languages. For more details, see Language element.

You can also just install proofing tools by specifying the Product ID as "ProofingTools" in your configuration.xml
file along with the appropriate Language IDs. Proofing tools packages, which are a new capability for Office 2019,
are much smaller than full language packs. Consider deploying proofing tools in cases where users work with
documents in multiple languages but don’t need the Office product Ul in all those languages. The proofing tools
can be installed at the same time you're installing Office 2019, or you can install them later. They can also be
installed whether or not the language pack for a given language is installed.

If you're upgrading from a Windows Installer (MSI) version of Office, you can get Click-to-Run versions of the
same language resources — for example, language packs, language interface packs, or proofing tools — installed
when you deploy Office 2019. For more information, see Remove existing MSI versions of Office when upgrading
to Microsoft 365 Apps. Even though this article is about Microsoft 365 Apps, most of the information also applies
to volume licensed versions of Office 2019.

Related topics

o OQOverview of Office 2019 (for IT Pros)
e Update Office 2019 (for IT Pros)

e Volume activation for Office
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Update Office 2019 (for IT Pros)
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After you deploy volume licensed versions of Office 2019, including Project and Visio, you'll want to keep it
updated as Microsoft releases security updates and quality updates, such as updates that provide stability or
performance improvements for Office. Office 2019 will be updated approximately once a month, usually on the
second Tuesday of the month.

NOTE

Office 2019 doesn't receive new features. If you want to get new Office features on an on-going basis, you should consider
moving to an Office 365 (or Microsoft 365) plan that includes Office.

Volume licensed versions of Office 2019 now use Click-to-Run, instead of Windows Installer (MSI), as the
technology used to install and update Office.

How Office 2019 gets updated

Click-to-Run handles updates differently than Windows Installer (MSI). The following provides information about
how updates work for Office 2019.

e When there are updates for Office 2019, Microsoft releases a new build of Office 2019 on the Office Content
Delivery Network (CDN) on the internet. This new build includes all the latest security and quality updates.

e By default, Office 2019 is configured to be updated automatically directly from the Office CDN, although that
can be changed. More on that later.

e There is a scheduled task named "Office Automatic Updates 2.0 ” on the computer on which Office 2019 is
installed that checks for updates on a regular basis.

e |f updates are available, Office begins downloading the updates automatically. The user doesn't have to do
anything. As part of this process, Office also figures out what's different between the latest version of Office
2019 up on the Office CDN and the version of Office 2019 that's installed on the computer. Based on that, it
only downloads what's needed to update Office 2019 to the latest version.

e While the updates are being downloaded, users can continue to use Office apps, such as Word. After the
updates are downloaded, the updates are installed. If any Office apps are open, users will be prompted to save
their work and close the apps, so that the updates can be installed.

o After the updates are installed, users can go back to working in their Office apps.

How updates are different in Office 2019

Since Click-to-Run handles updates differently than Windows Installer (MSI), there are some changes you need to
be aware of.

e There are no separate downloads for security or quality updates. Updates are already included as part of a new
build of Office 2019 that's posted on the Office CDN.

e Updates are cumulative, so the latest version of Office 2019 available on the Office CDN includes all the
security and quality updates from all the previous versions of Office 2019.

e When you download and install Office 2019 from the Office CDN, it's up to date already. You don't have to
download and apply any updates or service packs after you install Office 2019.

e Since updates are cumulative and already included in the latest version of Office 2019 on the Office CDN, you
don’t use Microsoft Updates or Windows Server Updates Services (WSUS) to update Office 2019. But you can


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/office2019/update.md

use Microsoft Endpoint Configuration Manager to help you deploy and manage updates to Office 2019,
including controlling when and from where updates are applied.

Configure where Office 2019 gets updates from

If network connectivity and other considerations based on your organizational requirements aren't an issue, we
recommend that Office 2019 is updated automatically from the Office CDN. Updating from the Office CDN is the
default, so there's nothing extra you need to do and it's an easy way to keep Office 2019 up to date.

If you don't want computers installed with Office 2019 to connect to the Office CDN to get updates, you can
configure Office 2019 to get updates from a shared folder from within your internal network. You still need a least
one computer to have access to the Office CDN to be able to download the latest version of Office 2019 to the

shared folder on your internal network.

Keep in mind that installing and updating Office 2019 from a shared folder on your local network requires
significantly more administrative effort and more disk space. For example, you have to keep track of when new
builds of Office 2019 are available and then download the updated version of Office 2019 to your network.
Downloading to a shared folder on your local network will always download a full copy of the updated version of
Office.

You can also use enterprise software deployment tools, such as Microsoft Endpoint Configuration Manager, to help
you update Office 2019.

The location where Office 2019 looks for updates is specified in the configuration.xml file that you use to deploy
Office 2019 with the Office Deployment Tool. For more information, see Deploy Office 2019 (for IT Pros). You can
also use Group Policy.

Check for updates for Office 2019

Instead of waiting for the scheduled task to run to check for updates, you can manually check for updates. To do
that, open any Office app, such as Word, and go to File > Account > Update Options > Update Now.

This causes the Click-to-Run service to go look for updates at the location that you've configured Office to look for
updates. For example, directly from the Office CDN on the internet. If updates are available, Office begins the

process to download.

Size of updates for Office 2019

The size of the updates that are downloaded to the user's computer from the update location varies depends on
several factors, including how long it's been since you last updated Office 2019 and how many security and quality
updates there are.

To minimize the size of the updates that need to be downloaded, we recommend that you keep Office 2019 up to
date. Office uses a technology called binary delta compression to help reduce the size of the updates that need to
be applied to the user's computer. But binary delta compression is only available if you're updating from a recent
version of Office. For example, if you're updating from the September or October version to the November
version. But if you're updating a much older version of Office, such as from the June to November version, binary
delta compression won't be available.

Update channel for Office 2019

Office uses the concept of update channels to determine which updates an installed version of Office receives. The
update channel is specified in the configuration.xml file that is used by the Office Deployment Tool. You should
always explicitly specify the update channel. For more information, see Deploy Office 2019 (for IT Pros).

"PerpetualVL2019" is the only supported update channel for Office Professional Plus 2019 and Office Standard



2019. It's also the default update channel for volume licensed versions of Project 2019 and Visio 2019, although
they can be installed with any update channel, such as Current Channel or Semi-Annual Enterprise Channel.

Update channel is a computer-wide setting. Which update channel you use should be determined by which version
of the Office suite that you're deploying. If you're deploying Project and Visio along with Office, they must use the
same update channel as the Office suite. This shouldn’t be an issue if all the versions of Office, Project, and Visio
are the 2019 volume licensed versions.

If you're deploying a volume licensed version of Project 2019 or Visio 2019 along with Microsoft 365 Apps, you
should specify the same update channel for Project 2019 and Visio 2019 that you're using for Microsoft 365 Apps.
For example, "Current" for Current Channel or “SemiAnnual” for Semi-Annual Enterprise Channel. For more
information, see Supported scenarios for installing different versions of Office, Project, and Visio on the same
computer.

Use Group Policy to specify update settings

If you have Windows Server and Active Directory Domain Services (AD DS) deployed in your organization, you
can configure update settings for volume licensed versions of Office 2019 by using Group Policy. To do this,
download the most current Administrative Template files (ADMX/ADML for Office), which include the policy
settings for Office 2019.

After you copy the Administrative Template files to AD DS, you'll find the update policy settings under Computer
Configuration\Policies\Administrative Templates\Microsoft Office 2016 (Machine)\ Updates in the Group Policy
Management Console. You'll also find a description of how to configure each policy setting. For example, you can
use the “Update path” Group Policy setting to specify where Office 2019 should look for updates.

Related topics

o Overview of Office 2019 (for IT Pros)
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Overview of volume activation of Office
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Applies to: Volume licensed versions of Office 2019 and Office 2016, including Project and Visio

Activation is the process of validating software with the manufacturer after it has been installed on a specific
computer. Activation confirms that the product is genuine—not a fraudulent copy—and that the product key or
serial number is valid and has not been compromised or revoked. Activation also establishes a link or relationship
between the product key and the particular installation.

NOTE

If you're a user trying to activate a personal copy of Office, see Activate Office instead of reading this article.

Volume activation is the process that Microsoft volume licensing customers use to automate and manage the
activation of Windows operating systems, Microsoft Office, and other Microsoft products across large
organizations.

There are three different methods that you can activate volume licensed versions of Office, including Project and
Visio:

e Key Management Service (KMS): Office is activated by contacting a KMS host computer on your
network.

e Multiple Activation Key (MAK): Office is activated online by Microsoft-hosted activation servers or by
telephone.

e Active Directory-based: Office on a domain-joined computer is activated through Active Directory.

Which activation method you choose depends on the size, network infrastructure, connectivity, and security
requirements of your environment. You can choose to use different activation methods for different versions of
Office and for different computers, for example desktops and laptops. Because these three activation methods are
also used to activate volume licensed versions of Windows, you might be able to use the same method to activate
both Windows and Office. For more information, see Volume Activation for Windows 10 and Volume Activation
Overview.

All volume licensed versions of Office, including Project and Visio, have a preinstalled product key, called a
Generic Volume License Key (GVLK), that can be used for KMS and Active Directory-based activation. You don't
have to enter a product key for each Office installation if you're activating Office by using KMS or Active Directory.
If you're activating Office by using MAK, you must enter a product key for each Office installation, but there are
ways to automate that.

Key Management Service (KMS) activation of Office

KMS activation is a client-server model in which each client requests activation from a KMS host computer. The
keys needed to activate Office are installed on the KMS host computer. The client uses DNS to locate a KMS host
computer to request activation.

For more information, see the following:

e Configure a KMS host computer to activate volume licensed versions of Office

e Configure DNS for activating volume licensed versions of Office by using KMS


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/vlactivation/plan-volume-activation-of-office.md
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e Activate volume licensed versions of Office by using KMS

Multiple Activation Key (MAK) activation of Office

MAK activation is used for one-time activation through Microsoft-hosted activation services, either via the internet
or by telephone. MAK activation requires that a MAK is installed on a client computer and instructs that computer

to activate itself against those services.

Each MAK has a predetermined number of allowed activations and is based on your volume licensing agreement.
Each Office activation that uses MAK counts toward the activation limit. After Office is activated, no re-activation is
required unless the hardware changes significantly.

For more information, see Activate volume licensed versions of Office by using MAK.

Active Directory-based activation of Office

Active Directory-based activation can activate Office installed on domain-joined computers. The product key
information, which is the same that is used by KMS, is stored in Active Directory and replicated throughout the
forest. If Office can't contact Active Directory for activation, Office tries to activate by using KMS.

For more information, see Activate volume licensed versions of Office by using Active Directory.

Related topics

e Microsoft Office Licensing


https://www.microsoft.com/licensing/product-licensing/office.aspx

Configure a KMS host computer to activate volume

licensed versions of Office
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Applies to: Volume licensed versions of Office 2019 and Office 2016, including Project and Visio

To activate volume licensed versions of Office, including Project and Visio, you must have a Key Management
Service (KMS) host computer. You can configure a Windows Server computer to be a KMS host computer by
installing the Volume Activation Services role and then running the Volume Activation Tools wizard.

To enable the KMS host computer to activate Office, you must install the Office Volume License Pack and enter
your KMS key on the KMS host computer. Then, you need to activate the KMS key over the internet or by
telephone.

If you have a KMS host computer configured to activate Windows, you can configure that same KMS host
computer to activate Office. You can also configure a KMS host computer to activate multiple versions of Office,
such as Office 2019 and Office 2016. In these cases, the KMS host computer must be running an operating system
that supports KMS for each of the versions of Office that you want to activate. You'll also need to install the Office
Volume License Pack for each version of Office on the KMS host computer and activate a KMS host key for each
version of Office.

Office supports KMS host computers running on the following operating systems, depending on which version of
Office is being activated by KMS:

e Office 2019: At least Windows Server 2012 or at least Windows 8.1 (volume editions)
e Office 2016: At least Windows Server 2008 R2 or at least Windows 7 Service Pack 1 (volume editions)

You can download the appropriate Office Volume License Pack from the Microsoft Download Center: Office 2019,
Office 2016. To get the KMS key, sign in to the Volume Licensing Service Center (VLSC) and download the KMS key
for each product and version of Office that you want KMS to activate.

NOTE

If you are setting up KMS on Windows 7 volume license edition or Windows Server 2008 R2, you must first install a patch as
described in Microsoft Knowledge Base article 2757817. This patch allows the KMS host computer to activate Office clients
that run on Windows 8.

Configure the KMS host computer

To configure the KMS host computer to activate Office, you must be a member of the Administrators group on the
KMS host computer.

If your KMS host computer has internet access, do the following steps:

1. Sign in to the Volume Licensing Service Center (VLSC) and download the KMS key for each product and version
of Office that you want KMS to activate.

2. On the KMS host computer, download the appropriate Office Volume License Pack from the Microsoft
Download Center: Office 2019, Office 2016.

3. Run the Office Volume License Pack executable file. Running the executable file will install the Office Volume
License Pack on the KMS host computer and then opens the Volume Activation Tools wizard.
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4. Follow the steps in the Volume Activation Tools wizard. Enter your KMS key when prompted.

5. If you have a firewall, make sure port 1688 is open to allow the KMS host service through the firewall.
e GotoControl Panel > System and Security > Windows Firewall.
e Click the Allow an app or feature through Windows Firewall link.
e C(lick the Change Settings button.

e Select the check box for Key Management Service and then choose OK.

If your KMS host computer doesn't have internet access, you can activate it by telephone.

1. From an elevated command prompt, go to the Windows\system32 folder, and then run the following
command:

cscript slmgr.vbs /dti ACTIVATIONID

Replace ACTIVATIONID with the Activation ID for your version of Office. The Activation ID for Office 2019 is
70512334-47B4-44DB-A233-BE5EA33B914C, and the 2016 Activation ID for Office 2016 is 98EBFE73-2084-
4C97-932C-COCD1643BEA7.

The result of running this command is a 36-digit installation ID. Paste the installation ID number into Notepad, and
then break it up into six groups of six numbers.

2. At the command line, run the following command:
slui.exe 4

This command launches the Windows phone activation wizard and it will display a telephone number.

After you've obtained the telephone number, cancel the wizard. You can ignore the activation ID displayed by the
wizard. It's for Windows.

3. Call the telephone number. At each prompt, enter a group of six numbers. This 36-digit number is the
installation ID that you obtained in step 1.

4. When you hear the response, write down the numbers. These numbers are your confirmation ID.

5. Atthe command ling, run the following command:
cscript slmgr.vbs /atp CONFIRMATIONID ACTIVATIONID

Replace CONFIRMATIONID with the 48-digit confirmation ID that you received over the telephone.

Replace ACTIVATIONID with the Activation ID for your version of Office. The Activation ID for Office 2019 is
70512334-47B4-44DB-A233-BE5EA33B914C, and the 2016 Activation ID for Office 2016 is 98EBFE73-2084-
4C97-932C-COCD1643BEA7.

6. You should see a message that the confirmation ID was successfully deposited.

Verify activations by the KMS host computer

After you set up the KMS host computer, KMS clients send requests for activation and increment the current count
of activations. The current count must be 5 or more before KMS clients are activated. The maximum current count
is double the activation threshold, or 10. You can also check the KMS log in the Applications and Services Logs
folder for event ID 12290, the ID for KMS-related activity. The KMS log records activation requests from KMS
clients. Each event displays the name of the computer and the time stamp of each activation request.



Verify the KMS key is successfully installed and activated

From an elevated command prompt on the KMS host computer, run the following command:
cscript slmgr.vbs /dlv all
To view information only for Office 2019, specify the Activation ID after the /dlv parameter. For example:
cscript slmgr.vbs /dlv 70512334-47B4-44DB-A233-BESEA33B914C

The following text is an example of the output. The line that says: "License Status: Licensed" indicates that your KMS
host computer is successfully activated.

Name: Office 16, OfficeKMSHostVL_KMS Host edition
Description: Office 16, VOLUME_KMS channel
Activation ID: 98EBFE73-2084-4C97-932C-COCD1643BEA7
Application ID: ©fflcel6-a989-479d-af46-f275c6370663
Extended PID: ©5426-00206-234-001162-03-1033-9200.0000-0992013
Installation ID: ©20650770493837252929082195773527024195725809211989214
Use License URL: https://activation.sls.microsoft.com/SLActivateProduct/SLActiva
teProduct.asmx?configextension=016
Validation URL: https://go.microsoft.com/fwlink/p/?LinkID=187557
Partial Product Key: KDQ2G
License Status: Licensed
Remaining Windows rearm count: 1000
Trusted time: 10/26/2016 9:58:33 AM
Key Management Service is enabled on this machine
Current count: 0
Listening on Port: 1688
DNS publishing enabled
KMS priority: Normal
Key Management Service cumulative requests received from clients
Total requests received: @
Failed requests received: ©
Requests with License Status Unlicensed: ©
Requests with License Status Licensed: ©
Requests with License Status Initial grace period: ©
Requests with License Status License expired or Hardware out of tolerance: ©
Requests with License Status Non-genuine grace period: ©
Requests with License Status Notification: @

Related topics

o Overview of volume activation of Office

e Activate volume licensed versions of Office by using Active Directory



Configure DNS for activating volume licensed

versions of Office by using KMS
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Applies to: Volume licensed versions of Office 2019 and Office 2016, including Project and Visio

To activate volume licensed versions of Office, including Project and Visio, by using Key Management Service
(KMS), the KMS host computer for Office must be discoverable. The KMS host computer automatically publishes its
existence by creating service (SRV) resource records (RRs) on the DNS server. But, only the first KMS host
computer can create an SRV RR. If there is more than one computer running KMS, subsequent KMS host
computers cannot change or update SRV RRs unless the permissions on the DNS server are configured to allow
this.

Changing the permissions on the DNS server requires administrative rights in the domain. You will need to set up
DNS as follows:

e Ensure that all computers running KMS are members of the same Active Directory Domain Services (AD DS)
domain.

e C(Create a global security group in AD DS for the computers running KMS.
e Add each computer running KMS to the new security group.

e Set the permissions on the DNS server to enable updates by members of the newly created security group.

For more information, see Configuring DNS.

How DNS is used to find a KMS host computer

The first time that a KMS client queries DNS for KMS information, it randomly selects a KMS host computer from
the list of SRV RRs that DNS returns. The address of a DNS server that contains the SRV RRs can be listed as a
suffixed entry on KMS clients. This enables advertisement of SRV RRs for KMS in one DNS server and KMS clients
that have other primary DNS servers to find it.

You can add priority and weight parameters to the DnsDomainPublishList registry value for KMS host
computers. Doing so enables you to establish priority groupings and weighting within each group, which specifies
the order in which to use KMS host computers and balances traffic among multiple KMS host computers. If you are
using priority and weight parameters, we recommend that you disable KMS caching on the client. For more
information, see Configure KMS host caching.

If the KMS host computer that a client selects does not respond, the KMS client removes that KMS host computer
from its list of SRV RRs and randomly selects another KMS host computer from the list. If the priority and weight
parameters are set, the KMS client will use them while finding another KMS host computer. Otherwise, KMS host
computers are selected randomly. After a KMS host computer responds, the KMS client caches the name of the
KMS host computer and, if caching is enabled, uses it for successive activation and renewal attempts. If the cached
KMS host computer does not respond on a later renewal, the KMS client discovers a new KMS host computer by
querying DNS for KMS SRV RRs.

Related topics

e Configure a KMS host computer to activate volume licensed versions of Office

e Activate volume licensed versions of Office by using KMS


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/vlactivation/configure-dns-to-activate-office-by-using-kms.md
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Applies to: Volume licensed versions of Office 2019 and Office 2016, including Project and Visio

All volume licensed versions of Office, including Project and Visio, have a Generic Volume License Key (GVLK)
preinstalled. GVLKs support both Key Management Service (KMS) and Active Directory-based activation. On the
KMS host computer configured to support volume activation of Office, you install and enable only one KMS host
key to activate all volume licensed versions of Office.

If the KMS host computer is available and properly configured, activation of Office occurs transparently to the user.
Office is activated the first time it runs, provided that there have been at least four previous activation requests to
the KMS host computer. This is because the KMS host computer requires at least five requests before it begins
activating clients.

You don't have to do anything else to enable activation of Office by KMS. KMS clients can locate a KMS host
computer automatically by querying DNS for service (SRV) resource records (RRs) that publish the KMS service.
For more information, see How DNS is used to find a KMS host computer.

If the network environment does not use SRV RRs, you can manually assign a KMS client to use a specific KMS
host computer by configuring the HKEY_LOCAL_MACHINE\Software\Microsoft\OfficeSoftwareProtectionPlatform
registry key on the KMS client. The KMS host computer name is specified by KeyManagementServiceName
(REG_SZ), and the port is specified by KeyManagementServicePort (REG_SZ). The default portis 1688. These
registry keys can also be set through by using ospp.vbs script. For more information about the ospp.vbs script, see
Tools to manage volume activation of Office.

Configure KMS host caching

You can configure whether or not the last used KMS host computer is saved to the cache on the KMS client. If the
KMS host computer is not cached, the KMS client will query DNS every time that activation is attempted. This
means that the priority and weight parameters set for KMS host computers will be honored. If the KMS host
computer is cached, the KMS client won't query DNS and instead will attempt to contact the cached KMS host
computer that last resulted in successful activation.

To configure KMS host caching, you can use the opss.vbs script. For more information about the ospp.vbs script,
see Tools to manage volume activation of Office.

To configure KMS host caching, open an elevated command prompt on the KMS client computer and go to the
Program Files\Microsoft Office\Office16 folder. If you installed the 32-bit version of Office on a 64-bit operating
system, go to the Program Files (x86)\Microsoft Office\Office16 folder.

To disable KMS host caching, type the following command, and then press ENTER:
cscript ospp.vbs /cachst:FALSE
To enable KMS host caching, type the following command, and then press ENTER:

cscript ospp.vbs /cachst:TRUE


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/vlactivation/activate-office-by-using-kms.md

Check the license status of Office

The following table describes the license state of the Office with respect to activation.

LICENSE STATE

Licensed

Out-of-tolerance

Unlicensed notification

DESCRIPTION

By default, the KMS client requests activation with the KMS
host computer one time every seven days. (The number of
days is configurable.) This design allows the maximum possible
time for the client to be in the licensed state.

After the client is successfully activated, it remains in the
licensed state for 180 days. When in the licensed state, users
do not see any notification dialog boxes prompting them to
activate the client. After 180 days, the activation attempt
process resumes. If activation is continually successful, the
whole activation experience is transparent to the user.

If activation does not occur during the 180-day period, Office
goes into the out-of-tolerance state for 30 days. Users then
see notifications that request activation.

If activation does not occur during the out-of-tolerance state,
Office goes into the unlicensed notification state. Users then
see notifications that request activation and a red title bar.

You use the ospp.vbs script with the /dstatusall option to check the license state for all Office clients. Use the

/dstatus option to check the status of the local client. For more information about using the ospp.vbs script, see

Tools to manage volume activation of Office.

Related topics

o Overview of volume activation of Office

e Configure a KMS host computer to activate volume licensed versions of Office

e Configure DNS for activating volume licensed versions of Office by using KMS

e Tools to manage volume activation of Office

® GVLKs for KMS and Active Directory-based activation of Office 2019 and Office 2016

o Volume Activation Management Tool (VAMT) Technical Reference


https://docs.microsoft.com/en-us/deployoffice/vlactivation/gvlks
https://docs.microsoft.com/en-us/windows/deployment/volume-activation/volume-activation-management-tool
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Applies to: Volume licensed versions of Office 2019 and Office 2016, including Project and Visio

Multiple Activation Key (MAK) activation is used for one-time activation through Microsoft-hosted activation
services, either via the internet or by telephone. MAK activation requires that a MAK is installed on a client
computer and instructs that computer to activate itself against those services.

Each MAK has a predetermined number of allowed activations and is based on your volume licensing agreement.
Each Office activation that uses MAK counts toward the activation limit. After Office is activated, no re-activation is
required unless the hardware changes significantly.

There are two ways to activate computers by using MAK:

e MAK independent activation requires that each computer independently connect and be activated with
Microsoft, either over the internet or by telephone. MAK independent activation is best for computers that
have direct access to the internet.

e MAK proxy activation by using VAMT enables one computer with internet access to process activation
requests on behalf of multiple computers. MAK proxy activation is configured by using the Volume
Activation Management Tool (VAMT). MAK proxy activation is appropriate for environments in which
security concerns might restrict direct access to the internet or to development and test labs. For more
information, see Perform Proxy Activation.

Activate Office 2019 by using MAK

If you're using MAK to activate volume licensed versions of Office 2019, you specify the key in the
configuration.xml file used by the Office Deployment Tool when you deploy Office 2019 to the users in your
organization. For more information, see Deploy Office 2019 (for IT Pros).

Activate Office 2016 by using MAK

If you're using MAK to activate volume licensed versions of Office 2016, you can enter the key by using one of the
following supported methods:

e Before you install Office 2016, you can use the Office Customization Tool (OCT) or the Config.xml file.

e After you install Office 2016, you can use the product Ul, the Volume Activation Management Tool (VAMT),
the ospp.vbs script, or enable a non-admin user to activate using MAK.

Configure MAK activation in the Office Customization Tool (OCT)
To enter a MAK key by using the Office Customization Tool (OCT), follow these steps:

1. In the OCT, go to the Licensing and user interface page.

2. Select Enter another product key, and then in the Product key field, enter the multiple activation key
(five sets of five numbers or characters).

3. After making any other necessary changes in the OCT, save the .msp file in the Updates folder.
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NOTE

® For more information, see Office Customization Tool (OCT) 2016 Help: Overview and Office Customization Tool (OCT)
2016 Help: Licensing and user interface.

® You can activate Office 2016 automatically when you install by setting the AUTO_ACTIVATE property value to 1 in the
Config.xml file. For more information, see Setting element. (Even though this article is for an earlier version of Office, the
information also applies to Office 2016.)

Configure MAK activation in the Config.xml file

To enter a multiple activation key by using the Config.xml file, follow these steps:

1. Add the following line to the Config.xml file:

<PIDKEY Value="AAAAABBBBBCCCCCDDDDDEEEEE" />

Replace AAAAABBBBBCCCCCDDDDDEEEEE with your 25-character product key.

2. To apply the settings in Config.xml, at a command prompt, type the following command, and then press ENTER:

Setup.exe /config <path of Config.xml file>

NOTE

® For more information about the Config.xml file, see Config.xml file reference. (Even though this article is for an earlier
version of Office, the information also applies to Office 2016.)

® You can activate Office 2016 automatically when you install by setting the AUTO_ACTIVATE property value to 1 in the
Config.xml file. For more information, see Setting element. (Even though this article is for an earlier version of Office, the
information also applies to Office 2016.)

Change the key by using the product Ul
To change the Office 2016 product key on only one computer:

1. Open an Office 2016 application, such as Word.
2. GotoFile > Account.

3. Choose Change Product Key and enter the product key.

If you need to change the Office 2016 product key on multiple computers after Office is installed, we recommend
that you use Volume Activation Management Tool (VAMT) 3.1. For more information, see Volume Activation
Management Tool (VAMT) Technical Reference.

Enable a non-admin user to activate an Office by using MAK

An administrator can create a registry key that allows a standard user (that is, a user who isn't an administrator) to
activate Office 2016 by using MAK. By default, volume licensed versions of Office 2016 disable this behavior.

This can be used if you want a user to manually activate Office by using MAK, replace an existing key with a new
key, or switch from KMS to MAK activation.

To enable this behavior, add the following line to the Config.xml file:

<Setting Id="USEROPERATIONS" Value="1" />

Or, you can set the HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\OfficeSoftwareProtectionPlatform registry key
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to enable or disable standard user activation

e To enable, set "UserOperations"=dword:00000001
e To disable, set "UserOperations"=dword:00000000

NOTE

For more information about the Config.xml file, see Config.xml file reference. (Even though this article is for an earlier version
of Office, the information also applies to Office 2016.)

Deploying multiple MAK keys

In some organizations, different groups have different MAK keys for their volume licensed versions of Office,
Project, or Visio. Unfortunately, you can't include multiple MAK keys in the same configuration.xml file (for 2019
versions) or in the Office Customization Tool or config.xml file (for 2016 versions).

If you don't want to create separate XML files for each group, you could use one of these other methods:

e Volume Activation Management Tool (VAMT)
® 0spp.vbs script

e Enable a non-admin user to activate using MAK

Related topics

o QOverview of volume activation of Office

e Tools to manage volume activation of Office
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Applies to: Volume licensed versions of Office 2019 and Office 2016, including Project and Visio

Active Directory-based activation enables an organization to activate volume licensed versions of Office, including
Project and Visio, on computers that are joined to an Active Directory domain. Active Directory-based activation is
implemented as a role service on Windows Server and relies on Active Directory Domain Services to store an
activation object. For more information, see Activate using Active Directory-based activation.

Requirements for using Active Directory-based activation

To use Active Directory-based activation, the volume licensed version of Office, Project, or Visio must have a
Generic Volume License Key (GVLK) and must be installed on one of the following operating systems:

e Windows 10

Windows 8.1

Windows Server 2016
Windows Server 2012 R2
Windows Server 2012

Review the System requirements for Office to determine which operating systems are supported by the volume
licensed version of Office, Project, or Visio that you're deploying the users in your organization. For example, Office
Professional Plus 2019 is supported on Windows 10 but isn't supported on Windows 8.1.

Configure Active Directory-based activation

To configure Active Directory-based activation, you must have Domain Administrator and Enterprise Administrator
credentials.

1. Sign in to a domain controller in Active Directory and use Server Manager to install the Volume Activation
Services role.

2. Sign in to the Volume Licensing Service Center and get your KMS key for your version of Office.

3. Download the appropriate Office Volume License Pack from the Microsoft Download Center: Office 2019,
Office 2016.

4. Run the Office Volume License Pack executable file. This will install the Office Volume License Pack and
opens the Volume Activation Tools wizard.

5. Choose Next, and then on the Select Volume Activation Method page, choose Active Directory-
Based Activation.
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. On the Manage Activation Objects page, enter the KMS host key, which you got from the VLSC, and,

optionally, give it a name. Then choose Next.

. On the Activate Product page, either activate the KMS host key online or by phone, and then follow the

rest of the wizard instructions.

. When you're done, an Activation Succeeded page displays.

Additional information about Active-Directory based activation

Active-Directory based activation uses the same keys that are used by Key Management Service (KMS). But
Active Directory-based activation doesn't require a dedicated host computer, because the activation object is
replicated across all the domain controllers in the Active Directory forest.

A successful Active Directory-based activation of Office lasts for up to 180 days. The Software Protection
service running on the computer periodically attempts to re-activate Office by querying Active Directory for the

activation object. If Active Directory can't be contacted, Office will try to activate by using a discoverable KMS
host computer.

Related topics

o Overview of volume activation of Office

e GVLKs for KMS and Active Directory-based activation of Office 2019 and Office 2016
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Applies to: Volume licensed versions of Office 2019 and Office 2016, including Project and Visio

There is a 25-day grace period from the time of installation of Key Management Service (KMS) clients before
notifications to activate are displayed to the user. The 25-day grace period gives ample time for a KMS host
computer to be found and activation to succeed. If activation is successful, users don't see notifications to activate.

If you want to deploy a volume licensed version of Office, or Project or Visio, as part of an operating system image,
you must rearm your Office installation before you capture the image. If you do not rearm, users might see
notification dialog boxes at the time that the image is deployed, instead of 25 days after deployment.

Rearming does the following important tasks:

e Resets the grace timer to 30 days.
e Freezes the grace timer until either an Office application is run, or the ospp.vbs script is run.

e Resets the client computer ID (CMID). This is important because the KMS host computer uses the CMID to
determine the number of unique clients. You can use the ospp.vbs script to check the CMID.

For more information about the ospp.vbs script, see Tools to manage volume activation of Office.

You can rearm five times, unless you activate Office by using a KMS host computer. If you run out of rearms,
activating by using a KMS host computer lets you rearm once.

NOTE

Rearming is also recommended if you're activating a volume licensed version of Office, including Project and Visio, by using
Multiple Activation Key (MAK). If you're activating by using MAK and you don't remotely activate for end-users by using the
Volume Activation Management Tool (VAMT) or ospp.vbs, users see an activation dialog box the first time that an Office
application starts. The activation dialog box is slightly different 25 days after installation. Also, users might immediately see a
red title bar warning them of activation issues if Office wasn't rearmed before the image was captured.

Use the ospprearm command to rearm an Office installation

1. Verify that the user account that is performing this procedure is a member of the Administrators group on
the KMS host computer.

2. Close all Office applications.

3. Open an elevated command prompt and go to the Program Files\Microsoft Office\Office16 folder. If you
installed the 32-bit version of Office on a 64-bit operating system, go to the Program Files (x86)\Microsoft
Office\Office16 folder.

4. Type ospprearm.exe and then press Enter. If the rearm succeeds, the following message displays: "Microsoft
Office rearm successful."

5. Capture the image.


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/vlactivation/rearm-an-office-installation-on-an-image-when-using-kms-to-activate.md

IMPORTANT

Do not open an Office application or run ospp.vbs, or do anything else related to Office while the image is being
captured. Otherwise, the grace timer starts.

Related topics

e Overview of volume activation of Office
e Tools to manage volume activation of Office

e Volume Activation Management Tool (VAMT) Technical Reference


https://docs.microsoft.com/en-us/windows/deployment/volume-activation/volume-activation-management-tool

Tools to manage volume activation of Office
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Applies to: Volume licensed versions of Office 2019 and Office 2016, including Project and Visio

The Office Software Protection Platform script (ospp.vbs), the Software License Manager script (simgrvbs), and
the Volume Activation Management Tool (VAMT) can help you configure and test volume licensed versions of
Office, including Project and Visio. Before you read this article, we recommend that you read Overview of volume
activation of Office, Activate volume licensed versions of Office by using MAK, and Activate volume licensed
versions of Office by using Active Directory.

The ospp.vbs script

The Office Software Protection Platform script (ospp.vbs) enables you to configure volume licensed versions of
Office products, including Project and Visio. The opss.vbs script is located in the Program Files\Microsoft
Office\Office16 folder. If you installed the 32-bit version of Office on a 64-bit operating system, go to the Program
Files (x86)\Microsoft Office\Office16 folder.

Running ospp.vbs requires the cscript.exe script engine. To see the Help file, type the following command, and
then press ENTER:

cscript ospp.vbs /?
The general syntax is as follows:
cscript ospp.vbs [Option:Value] [ComputerName] [User] [Password]

Option Specifies the option and value to use to activate a product, install or uninstall a product key, install and
display license information, set KMS host name and port, and remove KMS host name and port. The options and
values are listed in the tables in this section.

ComputerName Name of the remote computer. If a computer name is not provided, the local computer is used.
User Account that has the required permission on the remote computer.

Password Password for the account. If a user account and password are not provided, the current credentials are
used.

IMPORTANT

Before you run the ospp.vbs, ensure that:

e |f you want to run the script on a remote computer, the Windows firewall allows Windows Management
Instrumentation (WMI) traffic on the remote computer.

® The user account you will use is a member of the Administrators group on the computer on which you run the script.

® You run ospp.vbs script from an elevated command prompt.

Global options for ospp.vbs

GLOBAL OPTION DESCRIPTION

Jact Activates installed Office product keys.


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/vlactivation/tools-to-manage-volume-activation-of-office.md

GLOBAL OPTION

/inpkey:value

Junpkey.value

Jinslic:value

/dstatus

Jdstatusall

/dhistoryacterr

/dinstid

/actcid-value

/rearm

/rearm:value

/ddescr.value

DESCRIPTION

Installs a product key (replaces existing key) with a user-
provided product key. Value option is required.

Uninstalls an installed product key with the last five digits of
the product key to uninstall (as displayed by the /dstatus
option). Value parameter is required.

Installs a license with user-provided path of the .xrm-ms
license. Value parameter is required.

Displays license information for installed product keys.

Displays license information for all installed licenses.

Displays the failure history for MAK/retail activation.

Displays Installation ID for offline activation.

Activates product with user-provided Confirmation ID. Value
parameter is required.

Resets the licensing status for all installed Office product keys.

Resets the licensing status for an Office license with a user-
provided SKUID value. Value parameter is required.

Use this option with the SKUID value specified by using the
/dstatus option if you have run out of rearms and have
activated Office through KMS or Active Directory-based
activation to gain an additional rearm.

Displays the description for a user-provided error code. Value
parameter is required.

The following table describes the ospp.vbs options for configuring the KMS client.

KMS client options for ospp.vbs

KMS CLIENT OPTION

/dhistorykms

/demid

/sethst:value

DESCRIPTION

Displays KMS client activation history.

Displays KMS client computer ID (CMID).

Sets a KMS host name with a user-provided host name. Value
parameter is required.

This sets
HKLM\Software\Microsoft\OfficeSoftwareProtectionPI
atform\KeyManagementServiceName (REG_SZ).



KMS CLIENT OPTION

/setprtvalue

/remhst

Jcachst:value

/actype:value

/skms-domain:value

/ckms-domain

Scenarios that use ospp.vbs

DESCRIPTION

Sets a KMS port with a user-provided port number. The
default port number is 1688. Value parameter is required.

This sets
HKLM\Software\Microsoft\OfficeSoftwareProtectionPI
atform\KeyManagementServicePort (REG_SZ).

Removes KMS host name and sets port to default. The
default port is 1688.

Allows or denies KMS host caching. Value parameter is
required (TRUE or FALSE).

(Windows 8 and later versions only) Sets volume activation
type. Value parameter is required.

Values: 1 (for Active Directory-based), 2 (for KMS), O (for
both).

(Windows 8 and later versions only) Sets the specific DNS
domain in which all KMS SRV records can be found. This
setting has no effect if the specific single KMS host name is
set by the /sethst option. Value parameter is the Fully
Qualified Domain Name (FQDN) and is required.

(Windows 8 and later versions only) Clears the specific DNS
domain in which all KMS SRV records can be found. The
specific KMS host is used if it is set by the /sethst option.
Otherwise, auto-discovery of the KMS host is used.

The following scenarios assume that you are running ospp.vbs in an elevated command prompt.

NOTE

Any changes that you make affect only the Office client products. You have to configure the Windows client separately by

using the slmgr.vbs script described in The slmgrvbs script later in this article.

To change the product key to a MAK key on a remote computer

1. If the remote computer is named contoso1, run the following command to enter the product key. This

assumes that you have administrator credentials on the remote computer. If your credentials on the

remote computer differ from your logon name and password, you must type your logon name and

password at the command line, and then press ENTER:

cscript ospp.vbs /inpkey:xxxxx-XXXXX-XXXXX-XXXXX-XXXXX contoso’l

2. To activate the remote computer, type the following command, and then press ENTER:

cscript ospp.vbs /act contoso1

To diagnose KMS activation errors

1. If the computer has the KMS client key installed, check the licensing status. To do this, type the following

command, and then press ENTER:

cscript ospp.vbs /dstatusall




2. To check the KMS activation history, type the following command, and then press ENTER:
cscript ospp.vbs /dhistorykms

3. To trigger activation, type the following command, and then press ENTER:
cscript ospp.vbs /act

4. Check the error message for error code 0xC004F042. If in the notification dialog boxes you see an error
code that is shown to users, you can also use that code to check the error message. To do this, type the
following command, and then press ENTER:

cscript ospp.vbs /ddescr:0xC004F042

To turn on or off KMS host caching on the KMS client

1. On the KMS client computer, to turn caching on, type the following command, and then press ENTER:
cscript ospp.vbs /cachst:TRUE

2. On the KMS client computer, to turn caching off, type the following command, and then press ENTER:
cscript ospp.vbs /cachst:FALSE

To test KMS host name, and then set to auto-discovery

1. If you are testing a KMS host named kmstest.contoso.com, and you want to specify it in the KMS client,
type the following command, and then press ENTER:

cscript ospp.vbs /sethst:kmstest.contoso.com

NOTE

If you change the default port on the KMS host computer, you must run ospp.vbs with the /setprt option. > For
example: cscript ospp.vbs /setprt:1750

2. To trigger activation, type the following command, and then press ENTER:
cscript ospp.vbs /act

3. To check the KMS activation history to see whether the host was successfully contacted, type the following

command, and then press ENTER:
cscript ospp.vbs /dhistorykms

4. Now you want this KMS client to use Domain Name System (DNS) for auto-discovery of the production
KMS host. To remove the KMS host name, type the following command, and then press ENTER:

cscript ospp.vbs /remhst

The sImgr.vbs script

The Software License Manager (sImgrvbs) script is used to configure and retrieve volume activation information
for the Office KMS host and the Windows host. For more information, see Configuring KMS Hosts for Windows.

You can run the script locally on the target computer or remotely from another computer. You have to be an
administrator to use the script. If a standard user runs simgr.vbs, some license data might be missing or
incorrect, and many operations are prohibited.

The sImgrvbs script can use the Windows-based script host, wscript.exe, or the command-based script host,
cscript.exe, and administrators can specify which script engine to use. If no script engine is specified, simgrvbs
runs by using the default script engine, wscript.exe. We recommend the cscript.exe script engine.


https://go.microsoft.com/fwlink/p/?LinkID=311942

You must restart the Software Licensing Service for any changes to take effect. To restart the Software Licensing
Service, use the Microsoft Management Console (MMC) Services snhap-in or run the following command:

net stop sppsvc && net start sppsvc

The slmgr.vbs script requires at least one parameter. If you run the script without any parameters, it displays Help
information. The following table lists simgrvbs command-line options, and a description of each. Most of the
parameters in the table configure the KMS host computer. However, the parameters /sai and /sri are passed to
KMS clients after the KMS clients contact the KMS host computer. The general syntax of simgrvbs is as follows

(assuming you are using the cscript.exe as the script engine):
cscript simgr.vbs /parameter
cscript simgr.vbs [ComputerName] [User] [Password] [Option]

ComputerName Name of the remote computer. If you do not provide a computer name, the local computer is

used.
User Account with required permission on the remote computer.

Password Password for the account. If you do not provide a user account and password, current credentials are
used.

Option Options are shown in the following table.

SImgr.vbs command options — standard

OPTION DESCRIPTION

/ ipk [ProductKey] Installs the product key for Windows (default) or other
application identified by the product key.

/ ato [Activation/D] Activates the KMS host for Windows (default), or the
application that is identified when its Activation ID is
provided. The Office 2019 Activation ID is 70512334-47B4-
44DB-A233-BESEA33B914C, and the Office 2016 Activation
ID is 98EBFE73-2084-4C97-932C-COCD1643BEA7.

/ dti [Activation/D] Displays the Installation ID that is used for telephone
activation of the KMS host computer for Windows (default) or
the application that is identified when its Activation ID is
provided. The Office 2019 Activation ID is 70512334-47B4-
44DB-A233-BESEA33B914C, and the Office 2016 Activation
ID is 98EBFE73-2084-4C97-932C-COCD1643BEA7. You
enter the Installation ID into the telephone to receive the
Confirmation ID, which is used for activating the KMS host
computer by using the /atp parameter.

/ atp [ConfirmationlIDj[ActivationID] After the Confirmation ID is received, activates the KMS host
for Windows (default) or the application that is identified
when its Activation ID is provided. The Office 2019 Activation
ID is 70512334-47B4-44DB-A233-BESEA33B914C, and the
Office 2016 Activation ID is 98EBFE73-2084-4C97-932C-
COCD1643BEA7.



OPTION

/ dlv [Activation/D]

/ dli [ActivationlD]

/ upk [ActivationlD]

/ xpr [Activation/D]

/ sprt [PortNumber]

/ cdns

/ sdns

/ cpri

/ sai [Activationinterval]

/ sri [Renewallnterval]

DESCRIPTION

Displays detailed license information for Windows (default), or
the application that is identified when its Activation ID is
provided. The Office 2019 Activation ID is 70512334-47B4-
44DB-A233-BESEA33B914C, and the Office 2016 Activation
ID is 98EBFE73-2084-4C97-932C-COCD1643BEA7.

For example, run the following command at the elevated
command prompt, in the C:\windows\system32 folder to get
the status of the Office KMS host:

cscript slmgrvbs /dlv 70512334-47B4-44DB-A233-
BESEA33B914C

Displays license information for Windows (default), or the
application that is identified when its Activation ID is
provided. The Office 2019 Activation ID is 70512334-47B4-
44DB-A233-BESEA33B914C, and the Office 2016 Activation
ID is 98EBFE73-2084-4C97-932C-COCD1643BEAT7.

Uninstalls the product key for Windows (default) or the
application that is identified when its Activation ID is
provided. The Office 2019 Activation ID is 70512334-47B4-
44DB-A233-BE5EA33B914C, and the Office 2016 Activation
ID is 98EBFE73-2084-4C97-932C-COCD1643BEA7.

CAUTION: If you intend to uninstall the product key for
Office, for example, and forget to enter the Activation ID, all
installed product keys are uninstalled. This includes the
product key for Windows.

Displays the expiration date for the current license state.

Sets the TCP communications port on a KMS host computer.
It replaces PortNumber with the TCP port number to use. The
default setting is 1688.

Disables automatic DNS publishing by a KMS host computer.

Enables automatic DNS publishing by the KMS host
computer.

Lowers the priority of KMS host computer processes.

Changes how often a KMS client attempts to activate itself
when it cannot find a KMS host computer. It replaces
Activation/nterval with a value expressed in minutes. The
default setting is 120 minutes.

Changes how often a KMS client attempts to renew its
activation by contacting a KMS host computer. It replaces
Renewallnterval with a value expressed in minutes. The
default setting is 10080 minutes (7 days). This setting
overrides the local KMS client settings.

The following table shows the command options for activating an AD DS forest by using Active Directory-based

activation.



SImgr.vbs command options — Active Directory-based activation

OPTION DESCRIPTION

/ ad-activation-online [ProductKey] Activates an AD DS forest through the user-provided product
key.

/ ad-activation-apply-get-iid [ProductKey] Displays installation ID for AD DS forest.

/ ad-activation-apply-cid [ProductKey][Confirmation/D] Activates an AD DS forest through the user-provided product

key and the Confirmation ID.

Volume Activation Management Tool (VAMT)

Volume Activation Management Tool (VAMT) provides a graphical user interface to manage volume activation.
For more information about VAMT, see Volume Activation Management Tool (VAMT) Technical Reference.

NOTE
Office 2019 requires at least VAMT 3.1.

Related topics

e Overview of volume activation of Office
e Activate volume licensed versions of Office by using MAK

e Activate volume licensed versions of Office by using Active Directory


https://docs.microsoft.com/en-us/windows/deployment/volume-activation/volume-activation-management-tool
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IMPORTANT

This information is for customers who deployed Office 2019 Preview as part of the Office 2019 Preview program on

Microsoft Collaborate.

If you're a volume licensed customer that's licensed for Office 2019 and you want to update your Office 2019
Preview installation, you don't need to uninstall Office 2019 Preview. You just need to activate the preview
installation in one of the following ways to get Office 2019:

e Key Management Service (KMS) for Office on Windows
e Multiple Activation Key (MAK) for Office on Windows

e Volume License (VL) Serializer for Office on a Mac
If you're not a volume licensed customer, you need to do the following:

e For Office on Windows, purchase Office 2019. After you purchase Office 2019, you need to uninstall Office 2019
Preview before installing Office 2019.

e For Office on a Mac, you don’t need to uninstall Office 2019 Preview for Mac. But, you need to purchase Office
2019 for Mac. Then, run the license removal tool and activate your existing installation.

WARNING

The client activation keys used in the Office 2019 Preview program expire on December 31, 2018. If you don't follow the
steps in this article, Office 2019 Preview will go into reduced functionality mode and your users will only be able to read and
print documents using Office 2019 Preview. Users will get periodic warnings about this in their Office apps, such as Word,
starting in early December.

KMS activation steps for Office on Windows

If you activate Office by using KMS, including Active Directory-based activation, do the following to update Office
2019 Preview to Office 2019.

e [f you haven't already done so, set up a KMS host computer. If you currently have a Windows KMS host
computer on an operating system that supports Office KMS, we recommend that you use the same computer
for your Office KMS host computer.

e Download the Office 2019 Volume License Pack from the Microsoft Download Center.

e Sign in to the Volume Licensing Service Center (VLSC) and get your KMS client activation keys for Office 2019.

e Configure the KMS host computer to activate Office 2019. You'll need both the Office 2019 Volume License Pack
and your KMS client activation keys.

e Make sure that you're using at least Version 1808 of Office 2019 Preview. To check your version, open Word,
and go to File > Account. Under the About Word section you'll see the version and build number.

e Run the ospp.vbs script on each computer to install and activate your KMS client activation key using the
commands below.


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/office2019/update-from-preview.md
https://support.office.com/article/b032c0f6-a431-4dad-83a9-6b727c03b193
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https://www.microsoft.com/licensing/servicecenter/default.aspx

cscript ospp.vbs /inpkey:yourkey
cscript ospp.vbs /act

Replace yourkey with your KMS client activation key. You will need to restart any Office apps to see these changes
take effect.

If you set up the Office 2019 KMS Host on a different computer than your Office 2019 Preview KMS host and you
aren't using Active Directory-based activation, then the previous commands might not work, so try running these
additional commands:

cscript ospp.vbs /remhst
cscript ospp.vbs /sethst:KMSHostFQDN
cscript ospp.vbs /act

Replace KMSHostFQDN with the fully qualified domain name of the Office 2019 KMS Host computer. You will need
to restart any Office apps for these changes take effect.

MAK activation steps for Office on Windows

If you activate Office by using MAK, do the following to update Office 2019 Preview to Office 2019.

e Sign in to the Volume Licensing Service Center (VLSC) and get your MAK client activation keys for Office 2019.

e Make sure that you're using at least Version 1808 of Office 2019 Preview. To check your version, open Word,
and go to File > Account. Under the About Word section you'll see the version and build number.

e Run the ospp.vbs script on each computer to install and activate your MAK client activation key using the
commands below.

cscript ospp.vbs /inpkey:yourkey
cscript ospp.vbs /act

Replace yourkey with your MAK client activation key. You will need to restart any Office apps for these changes take
effect.

Additional information for Office on Windows

e The ospp.vbs commands can be included in a script that you can deploy and run across the computers in your
organization. For example, by using Microsoft Endpoint Configuration Manager.

e You can also use the Volume Activation Management Tool (VAMT) 3.1 to centrally manage volume activation.
You need to use VAMT 3.1 with Office 2019. VAMT 3.0 won't work with Office 2019. For more information about
VAMT, see Volume Activation Management Tool (VAMT) Technical Reference.

e This information also applies to updating Project Professional 2019 Preview to Project Professional 2019 and
updating Visio Professional 2019 Preview to Visio Professional 2019.

e If you have the 32-bit version of Office 2019 Preview installed and want to install the 64-bit version of Office
2019, you need to uninstall Office 2019 Preview first. You also must uninstall Office 2019 Preview if you're
switching from the 64-bit version to the 32-bit version.

e If you're a volume licensed customer and you want to install Office Standard 2019, you need to uninstall Office
Professional Plus 2019 Preview first.

e For more information, see Plan volume activation of Office and Tools to manage volume activation of Office.

VL Serializer steps for Office on a Mac

If you're a volume licensed customer that's licensed for Office 2019 for Mac and you want to update Office 2019


https://www.microsoft.com/licensing/servicecenter/default.aspx
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Preview for Mac to Office 2019 for Mac, you don't need to uninstall Office 2019 Preview for Mac. You just need to
download the Volume License (VL) Serializer for Office 2019 for Mac from the Volume Licensing Service Center
(VLSC) and deploy to each computer running Office 2019 Preview for Mac.


https://www.microsoft.com/licensing/servicecenter/default.aspx
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How you deploy Project to the users in your organization depends on which version of Project you purchase. A
common purchase option for organizations is one of the following versions of Project:

e Project Online Desktop Client, available as a subscription with Project Plan 3 or Project Plan 5.

e Project Professional 2019 or Project Standard 2019, available as a one-time purchase through a volume
licensing agreement.

e Project Professional 2016 or Project Standard 2016, available as a one-time purchase through a volume
licensing agreement.

Before you deploy, be sure to review the system requirements for the version of Project that you plan to deploy to
the users in your organization.

IMPORTANT

There are some combinations of Office, Visio, and Project that can't be installed together on the same computer. For more
information, see Supported scenarios for installing different versions of Office, Visio, and Project on the same computer.

Deploy Project Online Desktop Client

Here are the general steps to deploy Project Online Desktop Client to users in your organization:

1. Purchase either Project Plan 3 or Project Plan 5, which includes Project Online Desktop Client, with enough
licenses for each of your Project users.

2. Sign in to Office 365 and assign licenses for Project Online Desktop Client to those users.

3. Have your users sign in to Office 365 and install Project from the Software section of the Office 365 portal.
Users have to be local administrators on their computers to install Project.

If you want to have more control over how Project is deployed to your users, you can do the following instead:
1. Download the Office Deployment Tool from the Microsoft Download Center.

2. Create a configuration.xml file to use with the Office Deployment Tool to download and install Project Online
Desktop Client.

3. Use the Office Deployment Tool to deploy Project Online Desktop Client on your users' computers.

If you already use other tools to deploy software to your users, such as Microsoft Endpoint Configuration Manager,
you can use the Office Deployment Tool along with those tools to deploy Project.

Deploy a volume licensed version of Project 2019

Here are the general steps to deploy a volume licensed version of Project Professional 2019 or Project Standard
2019 to users in your organization:

1. Purchase Project 2019 as part of a volume licensing agreement.

2. Use the Office Deployment Tool and a configuration.xml file to download and install Project from 2019 from
the Office Content Delivery Network (CDN) on the internet. For more information, see Deploy Office 2019
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(for IT Pros).

If you already use other tools to deploy software to your users, such as Microsoft Endpoint Configuration Manager,
you can use the Office Deployment Tool along with those tools to deploy volume licensed versions of Project.

NOTE

® Volume licensed versions of Project 2019 are available directly from the Office CDN instead of from the Volume Licensing
Service Center.

® Volume licensed versions of Project 2019 are installed by using Click-to-Run instead of by using Windows Installer (MSI).

® The Office Customization Tool (OCT) that's used for Windows Installer (MSI) versions of Project isn't used with volume

licensed versions of Project 2019.

Deploy a volume licensed version of Project 2016

Here are the general steps to deploy a volume licensed version Project Professional 2016 or Project Standard 2016
to users in your organization:

1. Purchase Project 2016 as part of a volume licensing agreement.
2. Download your version of Project 2016 from the Volume Licensing Service Center.

3. If you want to configure user settings for when Project is installed, you can use the Office Customization Tool
(OCT).

4. Deploy Project 2016 to your users. For example, you can send your users a script to run that installs Project
from a network share on your local network.

If you already use other tools to deploy software to your users, such as Microsoft Endpoint Configuration Manager,
you can use the Office Customization Tool (OCT) along with those tools to deploy Project.

NOTE

The Office Customization Tool (OCT) is only available for versions of Project 2016 that are purchased as part of a volume
licensing agreement. The OCT can't be used for retail versions of Project 2016, such as versions bought at a retail store or
online.

Configure user settings for Project by using Group Policy

If you want to specify and maintain certain user settings for your Project installations, you can download the Group
Policy Administrative Template files (ADMX/ADML) for Office and use them to configure Group Policy settings.
Group Policy can be used only with computers joined to a domain.

The same Group Policy settings work for Project Online Desktop Client, as well as volume licensed versions of
Project, such as Project Professional 2019 or Project Standard 2016.

End user resources for Project
To help your users get started with Project, here are some resources to share with them:

e What's new in Project 2019
e Project help center

e Get started with Project


https://www.microsoft.com/Licensing/servicecenter/default.aspx
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Related topics

e Documentation to help you plan, deploy, and manage Project Server and Project Online

e Plans and pricing information


https://docs.microsoft.com/en-us/project
https://products.office.com/project/compare-microsoft-project-management-software?tab=1
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How you deploy Visio to the users in your organization depends on which version of Visio you purchase. A

common purchase option for organizations is one of the following versions of Visio:

e Visio desktop app that comes with a Visio Plan 2 subscription.

e Visio Professional 2019 or Visio Standard 2019, available as a one-time purchase through a volume licensing
agreement.

e Visio Professional 2016 or Visio Standard 2016, available as a one-time purchase through a volume licensing
agreement.

Before you deploy, be sure to review the system requirements for the version of Visio that you plan to deploy to the
users in your organization.

IMPORTANT

There are some combinations of Office, Visio, and Project that can't be installed together on the same computer. For more
information, see Supported scenarios for installing different versions of Office, Visio, and Project on the same computer.

Deploy a subscription version of Visio

Here are the general steps to deploy a subscription version of Visio to users in your organization:
1. Purchase Visio Plan 2, with enough licenses for each of your Visio users.
2. Sign in to Office 365 and assign licenses for Visio to those users.

3. Have your users sign in to Office 365 and install Visio from the Software section of the Office 365 portal.
Users have to be local administrators on their computers to install Visio.

If you want to have more control over how the subscription version of Visio is deployed to your users, you can do
the following instead:

1. Download the Office Deployment Tool from the Microsoft Download Center.

2. Create a configuration.xml file to use with the Office Deployment Tool to download and install the
subscription version of Visio.

3. Use the Office Deployment Tool to deploy the subscription version Visio to the users in your organization.

If you already use other tools to deploy software to your users, such as Microsoft Endpoint Configuration Manager,
you can use the Office Deployment Tool along with those tools to deploy the subscription version of Office.

Deploy a volume licensed version of Visio 2019

Here are the general steps to deploy a volume licensed version of Visio Professional 2019 or Visio Standard 2019
to users in your organization:

1. Purchase Visio 2019 as part of a volume licensing agreement.

2. Use the Office Deployment Tool and a configuration.xml file to download and install Visio from 2019 from
the Office Content Delivery Network (CDN) on the internet. For more information, see Deploy Office 2019


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/deployment-guide-for-visio.md
https://products.office.com/office-resources
https://support.office.com/article/997596b5-4173-4627-b915-36abac6786dc
https://www.microsoft.com/download/details.aspx?id=49117
https://docs.microsoft.com/en-us/deployoffice/office-deployment-tool-configuration-options
https://docs.microsoft.com/en-us/deployoffice/overview-office-deployment-tool

(for IT Pros).

If you already use other tools to deploy software to your users, such as Microsoft Endpoint Configuration Manager,
you can use the Office Deployment Tool along with those tools to deploy volume licensed versions of Visio.

NOTE

® \olume licensed versions of Visio 2019 are available directly from the Office CDN instead of from the Volume Licensing
Service Center.

® Volume licensed versions of Visio 2019 are installed by using Click-to-Run instead of by using Windows Installer (MSI).

e The Office Customization Tool (OCT) that's used for Windows Installer (MSI) versions of Visio isn't used with volume

licensed versions of Visio 2019.

Deploy a volume licensed version of Visio 2016

Here are the general steps to deploy a volume licensed version of Visio Professional 2016 or Visio Standard 2016
to users in your organization:

1. Purchase Visio 2016 as part of a volume licensing agreement.
2. Download your version of Visio 2016 from the Volume Licensing Service Center.

3. If you want to configure user settings for when Visio is installed, you can use the Office Customization Tool
(OCT).

4. Deploy Visio 2016 to your users. For example, you can send your users a script to run that installs Visio from
a network share on your local network.

If you already use other tools to deploy software to your users, such as Microsoft Endpoint Configuration Manager,
you can use the Office Customization Tool (OCT) along with those tools to deploy Visio.

NOTE

The Office Customization Tool (OCT) is only available for versions of Visio 2016 that are purchased as part of a volume
licensing agreement. The OCT can't be used for retail versions of Visio 2016, such as versions bought at a retail store or
online.

Configure user settings for Visio by using Group Policy

If you want to specify and maintain certain user settings for your Visio installations, you can download the Group
Policy Administrative Template files (ADMX/ADML) for Office and use them to configure Group Policy settings.
Group Policy can be used only with computers joined to a domain.

The same Group Policy settings work for the subscription version of the Visio desktop app, as well as volume
licensed versions of Visio, such as Visio Professional 2019 or Visio Standard 2016.

End user resources for Visio
To help your users get started with Visio, here are some resources to share with them:

o What's new in Visio 2019

e Visio help center

Related topics


https://www.microsoft.com/Licensing/servicecenter/default.aspx
https://docs.microsoft.com/en-us/deployoffice/oct/oct-2016-help-overview
https://www.microsoft.com/download/details.aspx?id=49030
https://support.office.com/article/19b8e98d-9cf9-40ad-9277-eb65e3713a79
https://support.office.com/visio

e Plans and pricing information

e Visio licensing


https://products.office.com/visio/microsoft-visio-plans-and-pricing-compare-visio-options?tab=tabs-1
https://products.office.com/Visio/microsoft-visio-volume-licensing-visio-for-multiple-users
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There are two versions of OneNote that you can deploy to users in your organizations who have devices running
Windows:

e OneNote 2016, which is part of the Office suite.

e OneNote for Windows 10, which is included on devices running Windows 10.

Both versions are supported and continue to receive new features. For example, Dark Mode was added to OneNote
2016 in late 2019.

As of March 2020, OneNote 2016 is included alongside the other Office apps, such as Word, Excel, and PowerPoint,
when you deploy Microsoft 365 Apps or Office 2019. But, if you want to, you can exclude OneNote 2016 from
being installed. For more information, see OneNote 2016 deployment guidance.

Choose the version of OneNote for your organization

Both OneNote 2016 and OneNote for Windows 10 can be installed on the same device and used side by side. Each
version of OneNote can access and sync with the same cloud-based notebooks, such as notebooks stored in
OneDrive for Business, SharePoint Online, or SharePoint Server. Even though the notebooks are cloud-based, a
copy of each notebook is cached on the user's device so that users can access them even when the device isn't
connected to the internet. But, OneNote for Windows 10 can't use local notebooks, which are OneNote files that are
stored on the user's device or on a file share on the network.

You can provide users in your organization with both versions of OneNote so that they can choose which version
best suits their needs. Users can set which OneNote version is the default on their device. Or, you can decide to
provide only one version of OneNote on their devices running Windows.

OneNote 2016 might be the better choice for your organization in the following situations:

e Your users rely primarily on local notebooks and you don't want to migrate these notebooks to the cloud.

e Most of your existing users are already trained on OneNote 2016, or even OneNote 2013, so they're already
familiar with the user interface.

e You want to customize OneNote settings for your users, which is available through Group Policy.
OneNote for Windows 10 might be a better alternative for your organization in the following situations:

e Most of your users are new to OneNote. OneNote for Windows 10 has a user interface that is designed to be

easier to navigate for new users.

e Your organization supports OneNote on multiple platforms, such as Mac, web, and iPad. OneNote across these
platforms, including OneNote for Windows 10, have a consistent user interface.

For more information, see What's the difference between OneNote and OneNote 20167

OneNote 2016 deployment guidance

You can use the Office Deployment Tool or enterprise deployment software, such as Microsoft Endpoint
Configuration Manager, to include or exclude OneNote 2016 when you deploy Office in your organization.

As of March 2020, OneNote 2016 is included alongside the other Office apps, such as Word, Excel, and PowerPoint,
when you deploy Microsoft 365 Apps or Office 2019. There are no additional steps you need to take to include


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/deployment-guide-onenote.md
https://support.office.com/article/bb81fb88-968d-4c1a-818d-eec590deadef
https://support.office.com/article/f261140c-5ce8-4cf4-ad0b-c9e1cb953831
https://support.office.com/article/a624e692-b78b-4c09-b07f-46181958118f
https://docs.microsoft.com/en-us/deployoffice/overview-office-deployment-tool

OneNote 2016 with new installations of Office. But, always be sure to check the deployment settings before you

deploy, for example when using the wizards in Configuration Manager (current branch) or Microsoft Intune.

To add OneNote 2016 to an existing installation of Office
If Office is already installed on the device, but OneNote 2016 didn't get installed, you can run the Office

Deployment Tool on the device and use the following configuration.xml file to add OneNote 2016.

<Configuration>
<Add>
<Product ID="OneNoteFreeRetail">
<Language ID="Match0S"/>
</Product>
</Add>
</Configuration>

Although you're deploying the freemium version of OneNote, the first time the user opens OneNote after it's
installed, the license will update automatically to the same license as the version of Office already installed on the
device.

NOTE

Using OneNoteFreeRetail isn't supported with volume licensed versions of Office 2019, such as Office Professional Plus 2019
or Office Standard 2019. To add OneNote 2016 back to these versions of Office, run an Online Repair.

To exclude OneNote 2016 from being installed

There are different ways to exclude OneNote 2016 from being installed with Office, depending on which
deployment method you're using, as shown in the following table.

METHOD INSTRUCTIONS
Office Deployment Tool You can use the ExcludeApp element in your configuration.xml
file.

We recommend that you use the Office Customization Tool to
help you create your configuration.xml file.

Microsoft Endpoint Configuration Manager (current branch) In the Office 365 Client Installation wizard, you can set
OneNote 2016 to the Off position when you configure the
Office settings.

Microsoft Intune On the Configure app suite page, you can clear the check
box for OneNote 2016 in the Select Office apps drop-down
list.

But, if you're allowing your users to install Office for themselves from the Office 365 portal, there is no way to
exclude OneNote 2016 from being installed.

OneNote for Windows 10 deployment guidance

OneNote for Windows 10 is installed by default on computers running Windows 10. Users can also install it
directly from the Microsoft Store, if you allow them to install apps from there. In either case, updates to OneNote
for Windows 10 come directly from the Microsoft Store.

If you don't want your users to install apps directly from the Microsoft Store, you can set up the Microsoft Store for
Business in your organization. This allows you to control which Microsoft Store apps your users can install,
including OneNote for Windows 10. For more information, see Microsoft Store for Business overview


https://docs.microsoft.com/en-us/deployoffice/office-deployment-tool-configuration-options
https://docs.microsoft.com/en-us/deployoffice/overview-of-the-office-customization-tool-for-click-to-run
https://www.microsoft.com/p/onenote/9wzdncrfhvjl?activetab=pivot%3aoverviewtab
https://docs.microsoft.com/en-us/microsoft-store/microsoft-store-for-business-overview

If you plan to move your users to OneNote for Windows 10, make sure their notebooks have been moved to a
cloud storage location, such as OneDrive for Business. To do that, you can provide them the instructions in Move
OneNote notebooks from your computer to OneDrive.

If you plan to move your users from OneNote for Windows 10 to OneNote 2016, no steps are needed to migrate
their notebooks. All cloud-based notebooks associated with their user account will be accessible in OneNote 2016
after they sign in with that same user account.

Additional information about deploying OneNote

Configure OneNote 2016 settings: You can use Group Policy to configure certain OneNote 2016 settings for
your users. To use Group Policy, download the latest Administrative Template files (ADMX/ADML) for Office from
the Microsoft Download Center and implement the policy settings by using Active Directory Domain Services (AD
DS).

NOTE

® Group Policy requires the devices with OneNote 2016 to be joined to an Active Directory domain.
® Most of these same policy settings can be applied by using the Office cloud policy service, which doesn't require the
device to be joined to a domain.

® Neither Group Policy nor Office cloud policy service can be used with Microsoft 365 Apps for business or with OneNote
for Windows 10.

Support dates: In November 2019, we announced that mainstream support for OneNote 2016 will continue until
October 2023. Extended supported remains the same, ending in October 2025. These dates align with the support
dates for Office 2019. These specific support dates apply only to OneNote included with versions of Office, such as
Office Professional Plus 2016, that are available as a one-time purchase or through volume licensing agreements.

Supported languages: While both OneNote 2016 and OneNote for Windows 10 are available in most of the
same languages, there are a few differences. The lists of the supported languages are available here: OneNote
2016, OneNote for Windows 10

Other platforms: There are also versions of OneNote for Mac, iPad, iPhone, Android, and for web browsers. For
more information, see OneNote help & learning.

Related topics

Frequently Asked Questions about OneNote
What's new in OneNote for Windows 10

OneNote help & learning

OneNote info for developers


https://support.office.com/article/b43692ae-ce27-4ab9-a8ad-a2aed225e6a5
https://www.microsoft.com/download/details.aspx?id=49030
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https://techcommunity.microsoft.com/t5/Office-365-Blog/Your-OneNote/ba-p/954922
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https://support.office.com/article/26d30382-9fba-45dd-bf55-02ab03e2a7ec#ID0EAABAAA=Windows_Phone&ID0EAACAAA=Windows_Phone
https://support.office.com/OneNote
https://support.office.com/article/6582c7ae-2ec6-408d-8b7a-3ed71a3c2103
https://support.office.com/article/1477d5de-f4fd-4943-b18a-ff17091161ea
https://support.office.com/OneNote
https://developer.microsoft.com/onenote
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In many cases, you can install Office, Project, and Visio on the same computer. But, there are some combinations of
Office, Project, and Visio that can't be installed together on the same computer. The two main things that
determine whether Office, Project, and Visio can be installed together on the same computer are the version of the
product and the installation technology used to install the product. What governs whether an installation scenario

is supported are these two rules:

e You can'tinstall two products together that have the same version but use different installation technologies.

e You can'tinstall two products of different versions together if both products use Click-to-Run as the installation
technology and those products have overlapping Office applications.

See the example installation scenarios section for several examples of installation scenarios that are supported and
not supported, along with an explanation of why they are or aren't supported, based on the rules listed above.

Office releases and their version number

The following table shows Office releases that are currently supported by Microsoft, their associated version, and
all the possible installation technology. The information listed in the table also applies to releases of Project and
Visio. For example, the subscription version of the Project desktop app or Visio Professional 2016.

OFFICE RELEASE VERSION' INSTALLATION TECHNOLOGIES
Office 365 16.0 Click-to-Run

(and Microsoft 365) Microsoft Store

Office 2019 16.0 Click-to-Run

Microsoft Store

Office 2016 16.0 Click-to-Run
Windows Installer (MSI)
Microsoft Store

Office 2013 15.0 Click-to-Run
Windows Installer (MSI)

Office 2010 14.0 Windows Installer (MSI)

"You can find this version information by going to Control Panel > Programs > Programs and Features. You
can also find this version in the About dialog for the Office app. For example, open Word, and go to File >
Account > About Word. On the top line of the About Microsoft Word dialog box, you will see the version
number. For example, Microsoft Word 2019 MSO (16.0.10336.20044) 32-bit. For steps to find this version in
different Office releases, see Find details for other versions of Office.

IMPORTANT
Office 365, Microsoft 365, Office 2019, and Office 2016 all have the same version: 16.0



https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/install-different-office-visio-and-project-versions-on-the-same-computer.md
https://support.office.com/article/8e83dd74-3b83-4528-bda6-6ff6118f8293

Installation technologies used by Office

There are different ways to purchase Office, Project, and Visio. For example, you can purchase them as part of an
Office 365 (or Microsoft 365) plan, as a one-time purchase from a retail store, or through a volume licensing
agreement. How you purchase them, along with which Office release you purchased — for example, Office 365 or
Office 2016 — determines what installation technology is used to install Office.

The three installation technologies are:

e (lick-to-Run
e \Windows Installer (MSI)

e Microsoft Store

In newer releases of Office, you can go to File > Account in any Office app, such as Word, and the type of
installation technology is listed under the Product Information section.

Another way to tell which installation technology was used to install Office is to File > Account in any Office app.
Under the Product Information section, if you see an Update Options choice, Office was installed by using
Click-to-Run. If you don't see an Update Options choice, and you don't see any mention of Microsoft Store, then
Office was installed by using Windows Installer (MS]).

The Microsoft Store installation technology is only used when you purchase and install Office from the online
Microsoft Store.

You can't rely on just the product name and release to determine the installation technology used by Office. For
example, if you purchase Visio Standard 2016 from a retail store, it uses Click-to-Run. But, if you purchase Visio
Standard 2016 through a volume licensing agreement, it uses Windows Installer (MSI).

Example installation scenarios

Here are some example installation scenarios, whether they're supported, and an explanation of why they are or
aren't supported.

PRODUCTS TO INSTALL SUPPORTED? EXPLANATION

Microsoft 365 Apps Yes They use different installation
technologies (Click-to-Run and MSI)

Project Professional 2013 (volume and they are different versions (16.0

licensed) and 15.0)

Microsoft 365 Apps No They both use Click-to-Run and they
are different versions (16.0 and 15.0),

Access 2013 (retail purchase) but Microsoft 365 Apps already

includes Access.

Microsoft 365 Apps Yes They both use Click-to-Run, they are
different versions (16.0 and 15.0), and
Visio Professional 2013 (retail purchase) there is no overlap in applications.


https://www.microsoft.com/store/

PRODUCTS TO INSTALL SUPPORTED? EXPLANATION

Office Professional Plus 2019 (volume No, but there is an alternative They use different installation

licensed) installation method available. technologies (Click-to-Run and MSI),
but they are the same version (16.0).

Visio Professional 2016 (volume

licensed) For more information about the
alternative installation method that's
available, see Use the Office
Deployment Tool to install volume
licensed versions of Project 2016 and
Visio 2016.

Office Standard 2019 (volume licensed) Yes They use different installation
technologies (Click-to-Run and MSI)

Visio Standard 2013 (volume licensed) and they are different versions (16.0
and 15.0).

Microsoft 365 Apps No, but there is an alternative They use different installation
installation method available. technologies (Click-to-Run and MSI),

Visio Professional 2016 (volume but they are the same version (16.0).

licensed)
For more information about the
alternative installation method that's
available, see Use the Office
Deployment Tool to install volume
licensed versions of Project 2016 and
Visio 2016.

Microsoft 365 Apps Yes, but with a caveat. 2 They both use Click-to-Run and are the
same version (16.0).

Project Professional 2019 (volume

licensed)

Microsoft 365 Apps Yes, but with a caveat. 2 They both use Click-to-Run and are the

same version (16.0).
Visio Standard 2019 (retail)

% You must be using at least Version 1808 of Microsoft 365 Apps, because that's the earliest version that
recognizes Office 2019 products, including Project and Visio. Version 1808 or later is available in Current Channel,
Monthly Enterprise Channel, Semi-Annual Enterprise Channel (Preview), and Semi-Annual Enterprise Channel. For
Microsoft 365 Apps release information, see Update history for Microsoft 365 Apps.

Additional information

e Allinstalled products must be either the 32-bit version or the 64-bit version. For example, you can't install a 32-
bit version of Visio on the same computer with a 64-bit version of Office.

e Even though a particular installation scenario is supported, it might not be recommended. For example, we
don't recommend having two different versions of Office installed on the same computer, such as Office 2013
(MSI) and Office 2019 (Click-to-Run).

e Volume licensed versions of Office 2013 and Office 2016 use Windows Installer (MSI). Volume licensed
versions of Office 2019 use Click-to-Run. The same is true for volume licensed versions of Project and Visio.

e For Office 365, Microsoft 365, and Office 2019 products, all products installed on the computer must be using
the same update channel. For example, the volume licensed version of Office Professional Plus 2019 can only
use the PerpetualVL2019 update channel. Therefore, it can't be installed on the same computer that has the
subscription version of the Project desktop app using Semi-Annual Enterprise Channel or on the same
computer that has the subscription version of the Visio desktop app using Current Channel.


https://docs.microsoft.com/en-us/deployoffice/use-the-office-deployment-tool-to-install-volume-licensed-editions-of-visio-2016
https://docs.microsoft.com/en-us/deployoffice/use-the-office-deployment-tool-to-install-volume-licensed-editions-of-visio-2016
https://docs.microsoft.com/en-us/officeupdates/update-history-microsoft365-apps-by-date
https://docs.microsoft.com/en-us/deployoffice/overview-update-channels

Related topics

e Deployment guide for Project

e Deployment guide for Visio
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This guide is intended to help administrators and other IT professionals plan, implement, and maintain
deployments of Office for Mac in their organizations.

There are three versions of Office for Mac that are referred to in this guide:

e Office for Mac, which is available with any Office 365 (or Microsoft 365) plan that includes Office. For
example, the Office 365 E5 plan. This version is updated on a regular basis to provide new features. It also
receives security and quality updates, as needed.

e Office 2019 for Mac, which is available as a one-time purchase from a retail store or through a volume
licensing agreement. This version receives security and quality updates, as needed.

e Office 2016 for Mac, which is available as a one-time purchase from a retail store or through a volume
licensing agreement. This version receives security and quality updates, as needed, until October 13, 2020.

This guide covers the following areas:

e What's new for admins in Office for Mac

e Deployment options for admins for Office for Mac
e Deploy updates for Office for Mac

e Deploy preferences for Office for Mac

e QOverview of activation for Office for Mac

In addition to this guide, other information is available to help admins with Office for Mac deployments, including
the following:

e System requirements for Office, for installation requirements, such as supported operating systems.
e Office for Mac, for purchasing information.

e Office Help & Training, for help on how to use Office for Mac.


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/mac/deployment-guide-for-office-for-mac.md
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https://support.office.com
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Applies to: Office for Mac, Office 2019 for Mac, Office 2016 for Mac
There are two basic ways that you, as an admin, can deploy Office for Mac to users in your organization:
e Provide your users with the installer package file, and have them install Office for Mac for themselves

e Download the installer package file to your local network, and then use your software distribution tools to
deploy Office for Mac to your users

If you have an Office 365 (or Microsoft 365) plan, you can provide your users with instructions on how to
download and install Office for Mac for themselves. To install Office for Mac, a user has to be administrator on the
Mac or know an administrator account name and password.

But, if you deploy Office for Mac for your users, you have more control over the deployment, including which users
get Office for Mac and when. To plan your deployment, review the following information.

Download Office for Mac to your local network

The easiest way to download Office for Mac, and ensure you're always getting the most current version and build,
is to download directly from the Office Content Delivery Network (CDN) on the internet. Here are the links to the
installer packages for the Office suite, which contains all the applications:

e Office for Mac (for Office 365 or Microsoft 365 plans)
o Office 2019 for Mac (for retail or volume licensed versions)

e Office 2016 for Mac (for retail or volume licensed versions)

NOTE

® |[nstaller and update packages for individual applications are also available on the Office CDN. For links to those, see Most
current packages for Office for Mac.

® The same installer package is used for Office for Mac and Office 2019 for Mac. How you activate the product determines
whether you get the features for Office for Mac or the features for Office 2019 for Mac.

® Unlike Office 2016 for Mac, the installer package for Office 2019 for Mac isn't available on the Volume Licensing Service
Center (VLSC).

Deploy Office for Mac to users in your organization

Office for Mac uses the Apple Installer technology for installation. That means you can use the software distribution
tools that you normally use to deploy software to Mac users. Some of the most common tools are Jamf Pro, Munki,
and AutoPkg. You can also use Apple Remote Desktop and AppleScript.


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/mac/deployment-options-for-office-for-mac.md
https://support.office.com/article/4414eaaf-0478-48be-9c42-23adc4716658?#InstallSteps=Install_on_a_Mac
https://go.microsoft.com/fwlink/p/?linkid=525133
https://go.microsoft.com/fwlink/p/?linkid=525133
https://go.microsoft.com/fwlink/p/?linkid=871743
https://docs.microsoft.com/en-us/officeupdates/update-history-office-for-mac#most-current-packages-for-office-for-mac
https://www.jamfsoftware.com/products/casper-suite/
https://www.munki.org/
https://github.com/autopkg/autopkg
https://www.apple.com/remotedesktop/
https://developer.apple.com/library/mac/documentation/AppleScript/Conceptual/AppleScriptX/AppleScriptX.html

IMPORTANT

There are changes in Office for Mac to improve security, including implementing Apple app sandboxing guidelines. These
changes mean that you can't customize the app bundle before or after you deploy Office. Don't add, change, or remove files
in an app bundle. For example, even if you don't need the French language resource files for Excel, don't delete them. This

change prevents Excel from starting. Even though you can't customize app bundles, you can configure preferences for each

app.

Additional deployment information for Office for Mac

Whichever deployment method you decide to use, the following information can help you plan your Office for Mac

deployment.

What's new: Before you deploy, review the information about what's new for admins in Office for Mac. This
includes information about system requirements, language support, and new features.

Side-by-side installation: You can't have Office 2016 for Mac and Office 2019 for Mac installed on the
same computer. Also, you can't have Office for Mac (from an Office 365 or Microsoft 365 plan) along with
either Office 2016 for Mac or Office 2019 for Mac (both of which are one-time purchase versions) installed
on the same computer.

Deploying individual apps: Installer package files for individual applications are available on the Office
Content Delivery Network (CDN). For links to those, see Most current packages for Office for Mac.

Activation: To use Office for Mac, it needs to be activated. Before you deploy, review the information about
how activation works in Office for Mac.

Uninstalling: If you need to uninstall Office for Mac, you can follow these steps to completely remove
Office for Mac. Unfortunately, there is no program to uninstall Office for Mac automatically.

Office for Mac 2011: Support for Office for Mac 2011 ended on October 10, 2017. All of your Office for
Mac 2011 apps will continue to function. But, you could expose yourself to serious and potentially harmful

security risks. To completely remove Office for Mac 2011, follow these steps.

Upgrading to Office 2019 for Mac: If you're a volume licensed customer, you can upgrade to Office
2019 for Mac without uninstalling Office 2016 for Mac. You just need to download the 2019 version of the
Volume License (VL) Serializer from the Volume Licensing Service Center (VLSC) and deploy it to each
computer running Office 2016 for Mac. If you need to go back to Office 2016 for Mac after you've upgraded,
follow these steps.

Version numbers Version numbers of 16.17 or higher for retail or volume licensed installs indicate you
have Office 2019 for Mac. Office 2016 for Mac has version numbers of 16.16 or lower. Since the "major"
version (16) hasn't changed between Office 2016 for Mac and Office 2019 for Mac, application settings,
including policies, preferences, and preference domains are similar between the two versions. Also, add-ins
and other extensibility solutions that are compatible with Office 2016 for Mac will most likely be compatible
with Office 2019 for Mac or will require minimal testing.

Related topics

Deploy updates for Office for Mac

Deploy preferences for Office for Mac
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https://docs.microsoft.com/en-us/deployoffice/mac/overview-of-activation-for-office-for-mac
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Overview of the Volume License (VL) Serializer

6/4/2019 « 2 minutes to read « Edit Online

Applies to: Office 2019 for Mac, Office 2016 for Mac

The Volume Serializer (VL) is used to activate Office 2019 for Mac or Office 2016 for Mac as a volume licensed
version. It's an approximately 4 mb package file that you run on a user's computer, either before or after you've
installed Office.

Download the Volume License (VL) Serializer from the VLSC

To download the VL Serializer, do the following:

1. Sign in to the Volume Licensing Service Center (VLSC).
2. Select the Download and Keys tab.

3. Depending on the version that you're deploying, search for "Office 2019 for Mac Standard" or "Office 2016 for
Mac Standard.”

. Select the Download link in the results panel.

4

5. Select the Continue button at the bottom of the window.

6. Select the icon (circle with download arrow) to download the VL Serializer .iso file.
7

. Once the download is complete, mount the .iso file to extract the VL Serializer package file.

Make sure you have the correct VL serializer version for the version of Office that you're deploying to your users.

VERSION FILE NAME
Office 2019 for Mac Microsoft_Office_2019_VL_Serializerpkg
Office 2016 for Mac Microsoft_Office_2016_VL_Serializer.pkg

Then, deploy and run the VL Serializer package file on each computer that you want to activate Office as a volume
licensed version.

NOTE

® You can't use the VL Serializer for Office 2019 for Mac to activate a volume licensed version of Office 2016 for Mac.

® Volume licensed versions of Office 2019 for Mac have version numbers of 16.17 or higher. Volume licensed versions of
Office 2016 for Mac have version numbers of 16.16 or lower, such as 16.16.2 or 16.15.

Additional information about the VL Serializer

e The volume license is located in the /Library/Preferences/com.microsoft.office.licensingV2.plist directory.

e The licensing plist generated by the VL Serializer contains data that's encrypted by using the serial number of
the boot drive on the computer where it was generated. Upon each Office application launch, the plist is
decrypted by using the current boot drive serial number as the decryption key. If the data cannot be decrypted
(for example, boot drive serial number is different), Office will go into an unlicensed state without warning.

® Because the license plist file is encrypted using information from the computer on which it's installed, you can't
copy it to a different computer to activate Office on that computer.

e There's a single VL Serializer package that contains a single key that's shared between all volume licensed


https://github.com/MicrosoftDocs/OfficeDocs-DeployOffice/blob/live/DeployOffice/mac/volume-license-serializer.md
https://www.microsoft.com/licensing/servicecenter/default.aspx

customer installations.

e The VL Serializer package contains a binary executable that's named "Microsoft Office Setup Assistant.” It's this
executable that actually activates the volume license.

e [f you install the volume licensed version of Office 2016 for Mac from the .iso file downloaded from the VLSC,
you don't need to run the VL Serializer. That installer package already has the VL Serializer functionality built-in.
But, we recommend that you always download and install the most current version that's available on the Office
Content Delivery Network (CDN) on the internet. For more information, see Download Office for Mac to your

local network.

e The VL Serializer package is compatible with mobile device management (MDM) servers such as Microsoft
Intune, Jamf Pro, or FileWave.

Related topics

e OQOverview of activation for Office for Mac

e Deployment options for admins for Office for Mac
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